DATA CREDITS


AUTHOR

Jill Willison

U.S. GOVERNMENT RESTRICTED/LIMITED RIGHTS

Any software, documentation, and/or data delivered hereunder is subject to the terms of the License Agreement. In no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a minimum, use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in FAR §52.227-14 Alternates I, II, and III (JUN 1987); FAR §52.227-19 (JUN 1987) and/or FAR §12.211/12.212 (Commercial Technical Data/Computer Software); and DFARS §252.227-7015 (NOV 1995) (Technical Data) and/or DFARS §227.7202 (Computer Software), as applicable. Contractor/Manufacturer is ESRI, 380 New York Street, Redlands, CA 92373-8100, USA.

DISCLAIMER

THE DATA INCLUDED IN THIS WORK IS FROM AN INDEPENDENT COMPANY AND, AS SUCH, ESRI MAKES NO GUARANTEES AS TO THE QUALITY, COMPLETENESS, AND/OR ACCURACY OF THE DATA. EVERY EFFORT HAS BEEN MADE TO ENSURE THE ACCURACY OF THE DATA INCLUDED IN THIS WORK, BUT THE INFORMATION IS DYNAMIC IN NATURE AND IS SUBJECT TO CHANGE WITHOUT NOTICE. ESRI AND THE DATA VENDOR(S) ARE NOT INVITING RELIANCE ON THE DATA, AND ONE SHOULD ALWAYS VERIFY ACTUAL DATA AND INFORMATION. ESRI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. ESRI AND THE DATA VENDOR(S) SHALL ASSUME NO LIABILITY FOR INDIRECT, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.

ESRI, the ESRI globe logo, ArcGIS, the ArcGIS logo, ArcView, ArcEditor, ArcInfo, ArcMap, ArcCatalog, ArcScene, ArcGlobe, and www.esri.com are trademarks, registered trademarks, or service marks of ESRI in the United States, the European Community, or certain other jurisdictions.

Other companies and products mentioned herein are trademarks or registered trademarks of their respective trademark owners.
Animation in ArcMap Tutorial

IN THIS TUTORIAL

- **Exercise 1: Organizing your data in ArcCatalog**
- **Exercise 2: Viewing an animation**
- **Exercise 3: Creating a temporal animation**
- **Exercise 4: Animating data in a graph through time**

Animations can be created in ArcMap™, ArcScene™ or ArcGlobe™. With an animation, you can visualize changes to the properties of objects (such as layers, the camera, or the map extent). By altering layer properties, such as the time stamp that is displayed or layer visibility and transparency, you can create interesting animations that can be used to analyze data through time or to view information in various layers. By altering the extent (ArcMap) or the camera position (ArcScene or ArcGlobe), you can create an animation that moves around a map, scene or globe. Examples of applications that would benefit from being viewed as an animation include:

- The occurrence of events through time, such as hurricanes or precipitation, the spread of a disease, or population change
- The navigation of an object (such as a car) through a landscape
- A visualization of information in multiple layers by applying transparency

In this tutorial, in the ArcMap display and in a graph, you’ll create an animation using feature class layers to examine population change for the contiguous USA for the period 1800 to 2000. The steps used in setting up the animation can be applied to raster catalog layers, network Common Data Form [netCDF] layers, and tables, and are also applicable in ArcScene and ArcGlobe (except the creation of graphs).

To use this tutorial, ArcGIS® must be installed and you must have the Animation in ArcMap tutorial data installed on a local or shared network drive on your system. Ask your system administrator for the correct path if you do not find it at the default installation path specified in the tutorial.
Exercise 1: Organizing your data in ArcCatalog

Since you’ll make changes to the Animation in ArcMap folder and will therefore need to have write access to the data within the folder, you will begin this exercise by making a working copy of the Animation in ArcMap tutorial folder. You will use ArcCatalog™ to browse to and copy the folder.

Copying the tutorial data

1. Start ArcCatalog by either double-clicking a shortcut installed on your desktop or using the Programs list on your Start menu.
2. If the Location toolbar is not present, click View, Toolbars and click Location.
3. Click the Location combo box and type the path to the \arcgis\ArcTutor folder on the drive where the tutorial data is installed. Press Enter.
4. Right-click the Animation in ArcMap folder and click Copy.
5. Right-click the local drive where you want to place the tutorial data (for example, C: \) and click Paste. The folder is copied to your local drive.

Connecting directly to your tutorial data

In ArcCatalog, folder connections allow you to access specific directories on local disks or shared folders on the network.

1. Click the Connect To Folder button.
2. Navigate to and select your local copy of the Animation in ArcMap tutorial folder.
3. Click OK.
4. Click File and click Exit.

The new folder connection is listed in the Catalog tree. You will now be able to access all the data needed for this tutorial via the new connection.
Visualizing changes in data over time can reveal insightful information about historical patterns and future potential change. Data that can be animated through time includes netCDF, raster catalog, and feature class layers. Once the data source for any of these layers is added to the application as a layer, the steps for setting up the temporal animation are the same.

In this exercise, you’ll animate feature class layers to examine population change. You’ll open an existing map document containing an animation and play it. You’ll examine changes in recorded county and state population figures over time for the contiguous USA from the year 1800 to the year 2000. You’ll examine county population data in the ArcMap display and state population data in a graph. In exercises 3 and 4, you’ll create the animation from scratch to learn the sequence of steps that are involved.

Opening an existing map document

You’ll begin by starting ArcMap and opening a map document containing the final animation that you will create in exercises 3 and 4.

1. Start ArcMap by using the Programs list on your Start menu.

2. If the ArcMap startup dialog box appears, check An existing map, then double-click Browse for maps. If you previously checked Do not show this dialog again on the ArcMap startup dialog box, open the map document by clicking Open instead.

3. Navigate to the Animation in ArcMap folder on your local drive, click Population_Change_Final.mxd, then click Open.

A map of population figures per county within the contiguous USA and a graph displaying population figures by state are displayed.
**Playing the animation**

You’ll now play the animation to gain an understanding of what can be achieved by animating data through time.

1. Click View, point to Toolbars, then click Animation.

2. Click the Animation drop-down arrow and click Animation Manager.

3. Click the Time View tab. The Time View tab allows the time slices of an animation to be previewed.

4. Click in the Time View display area (in the position shown by the red time slider in the graphic) to view the population figures recorded in the 10-year period after 1800.

5. Resize or move the Animation Manager so you can see the northeast portion of the country in the map display. It is easy to see that at this time, the population was clustered around this area of the country.

The format of the displayed time text is dependent on your computer’s regional time settings, so your time text format might be different from that in the graphics.
6. Click in the Time View display area (in the position shown by the red time slider in the graphic) to view population figures recorded in the 10-year period after 1990. You may need to move the Animation Manager to see the counties in the West. There has been a significant increase in recorded population farther west by this time period.

7. Click Close on the Animation Manager.

8. Click the Open Animation Controls button.

9. Click the Play button to see the entire animation play in the ArcMap display and in the graph.

10. Click Close ("X") on the Animation Controls dialog box.

11. Click the New Map File button.

12. Click No when asked to save the map document.
Exercise 3: Creating a temporal animation

The procedure for creating an animation through time is the same in ArcMap, ArcScene, and ArcGlobe, and the layer’s data source can be a netCDF file, a raster catalog, or a feature class.

In this exercise, you’ll create an animation to view changes in recorded county population figures over time for the contiguous USA from the year 1800 to the year 2000. You’ll use the County Population feature class layer, and you’ll animate it in the ArcMap display.

Opening the map document

1. Click File and click Open.
2. Navigate to your Animation in ArcMap folder and double-click Population_Change_Start.mxd.

The map contains two layers, State Population and County Population for the contiguous USA. Each layer contains population figures recorded from the year 1800 to 2000, in 10–year increments. In this exercise, you’ll set up an animation to animate the county data in the map display. In the next exercise, you’ll create a graph using the state data and animate it alongside the county data.

3. Click File and click Save As.
4. Navigate to your Animation in ArcMap folder and type Population_Change.mxd for the name of the map document.
5. Click Save.
Creating the time layer track

Animations consist of tracks. Tracks are bound to objects (such as layers, the map view [ArcMap], the camera [ArcScene and ArcGlobe], or the scene [ArcScene]) whose properties can be animated. You can create an animation that navigates through a scene or globe or pans and zooms around a map by creating a camera or a map view track, respectively. You can create an animation that alters layer properties, such as transparency or visibility, by creating a layer track. Scene properties, such as the background, can be animated by creating a scene track. Data (in the form of feature class, netCDF, or raster catalog layers) can be animated through time in ArcMap, ArcScene, or ArcGlobe by creating a time layer track. All that is required is a time field in the attribute table, or a time dimension for netCDF layers. The ‘Building animations’ section of the ArcGIS Desktop Help explains how to create the various track types for use in an animation.

Tracks are composed of keyframes, which are a snapshot of the object’s properties at a certain time during the animation. For time layer tracks, each keyframe stores a time, and the interval (such as 10) and units (such as years) that will be applied between that keyframe and the next one. To create a time layer track, you’ll first create an empty track and create the keyframes that it will store.

1. Click Animation and click Create Keyframe.

2. Click the Type drop-down list and click Time Layer as the type of track you’ll create to store the keyframes.

3. Click the Source object drop-down list and click County Population.

4. Click New to create a new time layer track with a default name. You’ll rename the track later.

All that is required to create an animation through time is a start and an end keyframe (though multiple keyframes can be created if you want to animate, for example, hourly time stamps for the first half of an animation and daily time stamps for the second half). Later in this exercise, you’ll learn how to set the time for each keyframe, between which time stamps will display based on the interval and units that you’ll specify.

5. Type “Start Time” for the name of the first keyframe you’ll create within the time layer track.

6. Click Create once to create this keyframe. Be careful to only click Create once. It is easy to unintentionally create multiple keyframes. If you clicked Create more than once, close this dialog box, click Animation, and click Clear Animation. Then start again from step 1 of this section.

1. Click Animation and click Create Keyframe.

2. Click the Type drop-down list and click Time Layer as the type of track you’ll create to store the keyframes.

3. Click the Source object drop-down list and click County Population.

4. Click New to create a new time layer track with a default name. You’ll rename the track later.

5. Type “Start Time” for the name of the first keyframe you’ll create within the time layer track.

6. Click Create once to create this keyframe. Be careful to only click Create once. It is easy to unintentionally create multiple keyframes. If you clicked Create more than once, close this dialog box, click Animation, and click Clear Animation. Then start again from step 1 of this section.
7. Type “End Time” for the name of the second keyframe you’ll create within the time layer track.
8. Click Create to create the second keyframe.
9. Click Close.

10. Click the Animation drop-down arrow and click Animation Manager.

11. Click the Tracks tab.

12. Click the value set for the name of the track (Time Layer track 1) and change it to USA Pop Change.

The time layer track has been created, but you need to set the time field or fields you’ll use to animate the County Population data, the time for each keyframe, and the interval and units you want to use to display time slices between keyframes.

**Setting time layer track properties**

1. Click at the beginning of the track to select it and click Properties.

2. Click the Time Track Properties tab.

The source object (a layer in this case) to which a track is attached can have one time field or a start time field and an end time field. It is useful to have an end time field in cases where the time stamps are irregularly spaced so that there will always be a time stamp displayed as the animation is played.
3. Click the Start Time Field drop-down arrow and click DATE_ST for the field to use from the County Population layer.

Since this is a date-formatted field, the Format drop-down list is disabled. If your field was a string or a double, you would be required to set the field format.

4. Click the End Time Field drop-down arrow and click DATE_END. This field is also a date-formatted field.

5. Click Calculate Times.

Calculate Times finds the minimum and maximum values in the Start Time Field specified and populates these as the time values for the two keyframes you created.

The Start Time keyframe you created will now have a time value of January 1, 1800. The End Time keyframe will now have a time value of January 1, 2000. You’ll see these values set on the Keyframes tab of the Animation Manager later.

You want the time of each time slice that is displayed to also show in the display when the animation is playing.

6. Ensure that Show time in the display is checked and that Show track name in the display is unchecked, since you only have one track in this animation.

7. Click OK.

**Modifying keyframe properties**

1. Click the Keyframes tab and notice the time values that have been populated for each keyframe in the Time column.

Since this data is in 10-year intervals, you’ll set the interval for each keyframe to 10 and the units to years.

2. Click the value for the interval of the Start Time keyframe and type “10”, then repeat this for the End Time keyframe.
3. Click the value for the units of the Start Time keyframe and click Years from the dropdown list. Repeat this for the End Time keyframe.

<table>
<thead>
<tr>
<th>Time</th>
<th>Interval</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>1800-01-01</td>
<td>10</td>
<td>Days</td>
</tr>
<tr>
<td>2000-01-01</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Previewing time slices

Your animation is now set up. You can preview slices of the animation on the Time View tab.

1. Click the Time View tab and click in the location shown to view the data in the year 1800.

2. Click the Select Elements tool on the Tools toolbar.

3. Double-click the time text in the display.

4. Click Change Symbol on the Text tab.

The space between each tick mark on the track line represents each 10-year period. After the second tick mark, the time slice displayed will change from 1800 to 1810. Note the animation time (from 0.000 to 1.000) at the bottom of the Time View display. All tracks operate within this animation time.

You can see that the majority of the population at that time lived in the northeastern USA.
5. Click the Size drop-down arrow and click 24.
6. Choose bold for the style.
7. Click OK, then click OK on the Time display dialog box.

8. Click the text in the display and move it to a location where it can be seen more clearly, then click away from the text to remove the blue dashed outline.

9. Click in the location shown on the Time View tab display to view the time slice for 1850.

Notice that the population of places in the West, such as California, is starting to be recorded during this 10-year period. Also notice that the time text has changed to the year 1850.

10. Click in the location shown on the Time View tab display to view the time slice for the 10-year period after 1990.

9. Click in the location shown on the Time View tab display to view the time slice for 1850.
Notice that the West’s population has increased, particularly in Los Angeles county in Southern California (the county shown in the darkest color).

With Restore state after preview checked, closing the Animation Manager would remove the time text and the layer would go back to its original state. The current definition query set to show the time slice for 1990 would be removed.

11. Ensure that Restore state after preview is unchecked so that the currently displayed time slice and the symbology and position of the time text will be retained in the display after the Animation Manager is closed.

Note that if you need to restore the state of your data after the animation has played, you can set the default symbology for the time text via the Draw toolbar instead.

12. Click Close.

13. Click File and click Save to save your map document up to this point.

Playing the animation

You’ll now play the entire animation using the Animation Controls dialog box.

1. Click the Open Animation Controls button.

2. Click Options.
3. Click By number of frames and click Calculate.
   This calculates the number of frames necessary to draw all the time slices when playing the animation.
4. Set the Frame duration to 1.0 if it isn’t already set to this value.
5. Uncheck Restore state after playing so that the original state of the data before the animation was played is not restored after the animation has played. The final time slice and time text will be retained.
6. Click Options to hide the play and record options so you can see the animation in the display.
7. Click the Play button.

   ![Animation Controls](image)

   Examine the increase in recorded population over time.
8. Click File and click Save.
   This exercise showed you how to create and play a temporal animation in the map display. In the next exercise, you’ll learn how to animate a graph alongside data that is animated in the map display.
   If you’re moving on to the next exercise, keep the map document open. If you want to stop and continue later, close the map document and reopen it to continue with exercise 4.
Exercise 4: Animating data in a graph through time

In this exercise, you’ll create a graph from the State Population layer to examine total population figures per state over time. You’ll attach the layer as a secondary source for the track. The data in the graph will then animate along with the data in the display. You’ll be able to spot general trends by viewing the state population figures in a graph.

Examining the attribute table

1. Right-click the State Population layer and click Open Attribute Table to examine the population figures.

2. Right-click the State_Name field and click Sort Ascending.

3. Scroll down the table and notice that the population for many states is listed as zero during the first half of the 1800s. This is because population figures only start being recorded for these states later in the 1800s.

4. Close the table.

Setting up a definition query

You’ll set up a definition query to show only those states that have population figures greater than zero. Doing so will mean only states that meet this criteria will display in the graph that you’ll create.
1. Right-click the State Population layer and click Properties.

2. Click the Definition Query tab.

3. Click Query Builder.

4. Double-click "Population" to add it to the expression box.

5. Click the > button.

6. Press the spacebar and type the value “0”.

   Your expression should be entered as “Population” > 0.

7. Click Verify to check the expression.

8. If the expression verifies successfully, click OK on the Verify expression box, click OK on the Query Builder dialog box, then click OK on the Layer Properties dialog box.

9. Click File, then click Save to save the map document.
**Creating a graph**

1. Click Tools on the Main Menu, point to Graphs, then click Create.

2. Click the Graph type drop-down arrow on the Create Graph Wizard and click Vertical Bar.

3. Click the Layer/Table drop-down arrow and click State Population.

4. Click the Value field drop-down list and click Population to set this as the value for the y-axis.

5. Click the X field drop-down arrow and click State_Name to set this as the value for the x-axis.

6. Set Ascending for the X field so that the state names will be displayed in ascending order.

7. Set the X label field to State_Name.

8. Uncheck Add to legend so the legend is not displayed in the graph.

9. Click Next.

10. In the General graph properties frame, type “State Population” in the Title text box.

11. Type “State Name” in the Title text box on the Bottom tab.
12. Click the Left tab and check that Population is set as the title for the Y Axis.

13. Click Finish.

A graph is created displaying the total population values for each state through time. Once the graph is animated later in this exercise, you’ll be able to see the population value per state through each time stamp.

Since you set a definition query of “Population” > 0, only those states with populations greater than zero will be displayed in the graph as it is animated. As time passes, more states will appear on the graph as their population is recorded. As more states appear, the graph’s x-axis will become crowded, and you won’t be able to read the names. Rotate the state names to overcome this problem.

14. Right-click the graph and click Advanced Properties.

15. Expand Chart, then expand Axis and click Bottom Axis.

16. Click the Labels tab.

17. Click the Style tab, and increase the Angle value to 90 degrees. Examine the effect this has on the graph’s x-labels.

You want the range of y-values in your graph to remain the same and not fluctuate depending on the data, so you’ll fix the maximum y-value.
18. In the Editing tree on the left side of the Editing dialog box, click Left Axis.
19. Click the Scales tab.
20. Click the Maximum tab and click Change.

21. Type “34000000” in the Value text box.
22. Click OK.

23. Click Close on the Editing dialog box.
24. Click File and click Save.

**Attaching the State Population layer to the time layer track**

You’ll now add the State Population layer as another attached object to the time layer track you created in exercise 3. Doing so will enable the data in the graph (the State Population layer) to animate at the same time as the data in the display (the County Population layer). Another way to achieve this result is to create another time layer track and attach the State Population layer to it.

1. Click Animation and click Animation Manager.
2. Click the Tracks tab and click the track to select it.
3. Click Properties.

4. Click the General tab, click State Population from the Available objects list, then click Attach.

5. Click the Time Track Properties tab and click State Population.
6. Click the Start Time Field drop-down arrow and click Start_Date.
7. Click OK.
8. Click Close on the Animation Manager dialog box.
9. Click File on the Main Menu and click Save.
**Playing the animation in the graph and the display**

Your animation is now ready to play in both the graph and the display.

1. Click Options on the Animation Controls dialog box to expand the Play options part of the dialog box.
2. Uncheck Restore state after playing so the last frame will be retained after playing the animation.
3. Click the Play button.

Examine the changes over time in the display and in the graph. The population increases in the West, and the state of California increases its population considerably.

**Exporting the animation to a video file**

Many times, you’ll need to present your animation to others. Rather than playing the animation in the display of the ArcGIS application, you can create a video of your animation by exporting to an Audio Video Interleaved (.avi) or QuickTime (.mov) file. This is especially useful when working with large datasets where the refresh rate can be slow, and it enables you to share your animations with others. Videos can take time to create, especially with large datasets, but once created, the video runs quickly.

1. Click the Animation drop-down arrow and click Export to Video.
2. Navigate to your Animation in ArcMap folder and type "My_Population_Change" in the File name text box.
3. Leave the default in the Save as type drop-down list as AVI (*.avi).
4. Click Options.
The Enable Off-Screen recording option is useful if you want to continue working while the animation is exporting. With the exception of graphs, windows opened on top of the ArcMap application will not appear in the exported video. The graph you created will be exported and included in the video file if you check Enable Off-Screen recording.

5. Check Enable Off-Screen recording.
6. Click OK.

7. Click Export. The Video Compression dialog box opens.
8. Click the Compressor drop-down arrow and choose a lossy compressor such as Cinepak Codec by Radius. Using a lossy compression results in a smaller video size than using a lossless compression, but text and data can be less clear.

It may take awhile to produce the video. The progress bar at the bottom left of the application will give an idea as to how much of the video has been created once you click OK. You can press Escape to cancel the export.

9. Click OK to export the video or click Cancel to stop the video export. You can play a video that has been created for you instead.

You can export animations from layout view in ArcMap, enabling you to export not only the display and the graph but also layout elements, such as the legend for the data in the display, a north arrow, scale bar, and so on.

10. Click File and click Save to save the map document.
11. Click File and click Exit to exit the ArcMap application.
12. Navigate on disk to your Animation in ArcMap folder and double-click My_Population_Change.avi to play the video. If you didn’t export the animation to video, double-click the video that was created for you (Population_Change.avi) to play that instead.
This brings you to the end of this tutorial. You’ve learned how to create an animation that shows layer attributes changing with time in the display and in a graph. These steps can be applied to any supported data type (netCDF, raster catalog, or feature class layers or tables) so use this tutorial as a guide when animating your own layers through time. Time layer tracks can be created in the same way in ArcScene and ArcGlobe, so you can animate your layers through time in those applications as well.

Other types of animations can be built by creating different track types. You can build a map view track to create an animation that moves around, and zooms in on, the map. You can build a layer track to create an animation that alters layer transparency or visibility. A scene track allows you to animate scene properties, such as the background color. These tracks can be built and animated alongside a time layer track to create visually interesting animations.

To learn more about creating animations, see the ‘Animation’ section of the ArcGIS Desktop Online Help system.